Key to

ALL ABOUT COMPUTERS

Keybooks are freely available at our website http://www.ProgressPublishers.com
1. NUMBER SYSTEM

A. 1. 8  
   2. 8000  
   3. D  
   4. 101  
   5. 0 with carry 1  

B. 1. number system  
   2. alphanumeric  
   3. binary  
   4. sixteen  
   5. face value  

C. 1. T  
   2. F  
   3. T  
   4. F  
   5. F  

D. 1. A number system defines a set of values used to represent different quantities. It plays a major role in manipulating and storing data in a computer. Different types of number systems are:  
   • Decimal number system  
   • Binary number system  
   • Octal number system  
   • Hexadecimal number system  

2. The face value of a digit in a number is the digit itself while the place value of a digit depends on its place or position in the number.  

3. The binary number system consists of only two digits- 0 and 1. So, the base of binary number system is 2. The digits 0 and 1 are known as binary digits or bits. A digital computer represents data and information using the binary number system. It is based on electronic circuits which have two states ON and OFF. The ON state is assigned the value 1, while the OFF state is assigned the value 0.  

4. The basic rules for binary multiplication are listed in the table given below.  

<table>
<thead>
<tr>
<th>Case</th>
<th>Input</th>
<th>Multiplication</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0 x 0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>1 x 0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>0 x 1</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>1 x 1</td>
<td>1</td>
</tr>
</tbody>
</table>
5. To convert a decimal number into a binary number
   • Divide the decimal number by two.
   • Write the remainder on the right-hand side.
   • Continue the process till you reach 0 as quotient.
   • Write the remainders from bottom to top to form binary equivalent of the decimal number. The first remainder becomes the last binary digit, and the final remainder becomes the first binary digit.

   E. a. 78  
   2 | 78  
   2 | 39  0  
   2 | 19  1  
   2 |  9  1  
   2 |  4  1  
   2 |  2  0  
   2 |  1  0  
   0 |  1  

   (78)\text{\textsubscript{10}} = (1001110)\text{\textsubscript{2}}

   b. 186  
   2 | 186  
   2 |  93  0  
   2 |  46  1  
   2 |  23  0  
   2 |  11  1  
   2 |  5  1  
   2 |  2  1  
   2 |  1  0  
   0 |  1  

   (186)\text{\textsubscript{10}} = (10111010)\text{\textsubscript{2}}

   F. a. (1010)\text{\textsubscript{2}} = 1 \times 2^3 + 0 \times 2^2 + 1 \times 2^1 + 0 \times 2^0  
   = 8 + 0 + 2 + 0  
   = (10)\text{\textsubscript{10}}

   b. (11111)\text{\textsubscript{2}} = 1 \times 2^4 + 1 \times 2^3 + 1 \times 2^2 + 1 \times 2^1 + 1 \times 2^0  
   = 16 + 8 + 4 + 2 + 1  
   = (31)\text{\textsubscript{10}}

   G. a.  
   \begin{array}{cccccc}
   1 & 1 & 1 & 1 & 1 \\
   \hline
   1 & 1 & 1 & 1 & 1
   \end{array}  

   (+)  
   \begin{array}{cccccc}
   1 & 0 & 1 & 1 & 1 \\
   \hline
   1 & 0 & 1 & 0 & 1
   \end{array}

   b.  
   \begin{array}{cccccc}
   1 & 0 & 1 & 0 & 1 & 0 \\
   \hline
   1 & 0 & 1 & 0 & 1 & 0
   \end{array}  

   (+)  
   \begin{array}{cccccc}
   1 & 1 & 0 & 0 & 1 & 0 \\
   \hline
   1 & 0 & 1 & 1 & 1 & 0
   \end{array}
2. FORMULAS IN EXCEL 2016

A. 1. formula  2. = C3 + $D$2  3. arguments
   4. #######  5. AppleBanana

B. 1. Functions  2. AutoSum  3. absolute
   4. #NAME?  5. relative

C. 1. T  2. F  3. T
   4. F  5. T

D. 1. 87  2. 29  3. 35
   4. 332  5. 109
E. 1. Cell reference can be entered in a formula in two ways –
   • By typing the cell reference.
   • By clicking a cell.

2. Three types of cell references in excel are:
   (a) Relative Reference - It is a cell reference in a formula that changes when the formula is copied from one cell to another cell. The references are changed with respect to the new cell where the formula is copied.
   (b) Absolute Reference - It is a cell reference in a formula that remains constant when the formula is copied from one cell to another cell. A cell reference is made absolute by putting a dollar sign before the column letter as well as the row number of the desired cell, e.g., $B$4.
   (c) Mixed Reference - It is a combination of a relative and absolute cell reference. In a mixed reference, one part of the cell address – column or row, is absolute while the other part is relative, e.g., $A4$ or $A$4.

3. Functions are in-built formulas in Excel that are used to perform calculations in worksheets. The basic structure of a function is $= \text{NAME} \left( \text{Arguments} \right)$. The function NAME is usually an abbreviated name of the function. The Arguments are the values that a function uses to perform calculations.

Some of the functions in Excel are:

SUM - Adds the value in the argument list.
PRODUCT - Multiplies the values in the argument list.
AVERAGE - Calculates the average of the values in the argument list.
COUNT - Counts the number of cells that contain numeric values in the argument list.

4. The AutoSum feature is used to quickly add the values in a selected cell range. It can be used to find the average, count, maximum and minimum of values in the selected cell range.

5. Five common errors that occur while using formula are:

<table>
<thead>
<tr>
<th>Error</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>#######</td>
<td>Occurs when a column is not wide enough to display the result.</td>
</tr>
<tr>
<td>#VALUE!</td>
<td>Occurs when a formula contains invalid data.</td>
</tr>
<tr>
<td>#DIV/0!</td>
<td>Occurs when a number is divided by 0.</td>
</tr>
<tr>
<td>#N/A</td>
<td>Occurs when a value that a formula uses is not available.</td>
</tr>
<tr>
<td>#NAME</td>
<td>Occurs when the text in a formula is not recognized by Excel.</td>
</tr>
</tbody>
</table>

6. Circular Reference occurs when a formula written in a cell uses its own cell reference – either directly or indirectly. For example, if you enter the formula =A2*B2+C2 in cell B2 and press the Enter key, a dialog box appears informing you that Excel has detected a circular reference. This happens because the value of cell B2 changes every time the formula is calculated and thus, the calculation goes on forever. Click the OK button in the dialog box to correct the formula.

**Think and Answer**

1. Yamini should increase the width of the column to display the result of the formula.

2. Aarav should place = sign before the formula to get the result.
3. ADVANCED FEATURES IN EXCEL 2016

A. 1. Flash Fill  
    2. descending order  
    3.  
    4. Conditional Formatting  
    5. Data

B. 1. Sort & Filter  
    2. Custom Filtering  
    3. Styles  
    4. text  
    5. Format Painter

C. 1. F  
    2. T  
    3. T  
    4. T  
    5. T

D. 1. The Flash Fill feature in Excel 2016 recognises the data pattern in a cell and fills other cells in a range using the same pattern. It usually works with tent data instead of numeric data.

Consider the given worksheet which consists of some famous Indian sportspersons with their First and the Last Name.

Let us use Flash Fill to combine their first and the last name.

(a) Type the full name of the first sportsperson in cell C3 and press the Enter key.

(b) Begin typing the second name in cell C4.

    - As you type, Flash Fill identifies the pattern used in cell C3 and displays suggestions for the cell range C4:C9.

(c) Press Enter key to accept the suggestions.

    - The cells C4 to C9 are filled automatically with the full names of the remaining sportspersons.
2. Sorting of data means to rearrange the data in a worksheet in a specific order. To sort the data on the basis of multiple columns in a worksheet:

(a) Select a cell range with two or more columns.
(b) On the Data tab, in the Sort and Filter group, click the Sort Button.
    • The Sort dialog box opens.
(c) Under Column, in the Sort By box, select the column on which you want to sort the data.
(d) Under Sort On, select Values.
(e) Under order, select –
    • A – Z or Z – A
    • Smallest to Largest or Largest to Smallest
    • Oldest to Newest or Newest to Oldest.
(f) Click the Add level button to add a new column to sort and repeat steps c to e.
(g) Click the OK button.
    • Excel sorts data according to the specified options.

3. The filter feature in Excel 2016 is used to display the rows that meets a specific criterion and hide rows that do not satisfy the criteria. You can use this feature to find and work with specified data in a cell range :-

To filter data on specific values in a cell range:

(a) Click a cell in the range that you want to filter.
(b) On the Data tab, in the Sort & Filter group, click the Filter button.
• The Filter Control appears next to each column heading.

(c) Click the Filter Control of the column heading on which you want to specify the filter condition.

• The Filter Menu appears. It displays a list of all unique values in the column.

(d) Remove the check marks for the values you want to hide.

OR

Remove the check marks before Select All and then, check mark the values you want to display.

(e) Click the OK button.

• Excel displays the rows containing the cells that match your filter condition.

• The row numbers of the filtered rows turn blue. A filter icon appears in the column heading of the column on which the filter is applied.

4. A Custom Filter helps you filter data based on specific conditions for values in a cell range.

To apply a custom filter:

(a) Click a cell in the range that you want to filter.

(b) Click the filter control of the column heading on which you want to specify the filter condition.

• The Filter menu appears.

(c) Point to Number Filters or Text Filters and click one of the predefined conditions or Custom Filter... from the sub-menu that appears.

• The Custom AutoFilter dialog box opens.
(d) Under Show rows where, select a filter condition, from the first list box and specify the desired value in the second list box.

(e) Click the OK button.

- Excel filters the selected data as per the specified filter condition.

5. The conditional formatting feature in Excel lets you apply formatting to cells according to the conditions you specify. Conditional formatting makes it easy to highlight certain values or identify particular cells. To remove conditional formatting:

(a) Select the cells on which conditional formatting is applied.

(b) On the Home tab, in the Styles group, click the Conditional Formatting button.

- A drop-down menu appears.

(c) Point to Clear Rules and click Clear Rules from Selected Cells or Clear Rules from Entire Sheet.

- Excel removes the conditional formatting as per the selected option.

Think and Answer

1. Flash Fill

2. Conditional Formatting

4. CREATING CHARTS IN EXCEL 2016


4. Style 5. Sparkline

B. 1. Win/Loss 2. Chart area 3. Treemap

4. legend 5. Chart Tools Design
5. T

D. 1. Chart is a visual representation of data, in which data is represented by symbols such as bars, lines or circles. A chart conveys the message behind the data it represents and makes comparisons and understanding trends much easier.

To move chart to a new chart sheet:
(a) Select the chart you want to move.
(b) On the Charts Tools Design tab, in the Location group, click the Move chart button.
   • The Move Chart dialog box opens.
(c) Do one of the following:
   • Click in the New Sheet box and type a name for the chart, to move chart to a new chart sheet.
   • Click the Object In down arrow and select the sheet to which you want to move the chart.
(d) Click the OK button.
   • Excel moves the chart as per the selected option.

2. Various chart elements are:
(a) Chart Title - Chart Title is a heading of the chart that usually describes what the chart represents.
(b) Chart Area - Chart Area refers to the area within which all the chart elements are placed. It is usually surrounded by a boundary.
(c) Plot Area - Plot Area is the area bounded by the two Axis in a chart.
(d) Axes - Axes represents the horizontal and vertical lines that surround the plot area in a chart.
(e) Axes Titles - Axes Title represent the descriptions for the X-axis and Y-axis.

(f) Data Series - Data Series refers to the set of values in a worksheet which is plotted in a chart.

(g) Data Table - Data Table displays the values, represented in the chart, in a grid at the bottom of the chart.

(h) Data Labels - Data labels show the values of different data points in a chart.

(i) Legend - The Legend identifies which data series each color on the chart represents.

(j) Gridlines - Gridlines are horizontal and vertical lines that make it easier to identify the value of each data point in a chart.

3. (a) A Column chart is used to show comparisons among a group of values or to display changes in data over a period of time. In a column chart, categories are represented on the horizontal axis and corresponding values are represented on the vertical axis.

(b) A Radar chart is used to make comparisons between data values in a series relative to a centre point. It represents the data in the form of spider web with categories represented on the vertices of the web. The data values are represented on a separate axis that starts in the centre of the web and ends on the outer ring of the web.

(c) A Waterfall chart is used to show the effect of a series of numbers (Positive or negative) on an initial value as a running total. The positive and negative numbers are represented in different colors.
(d) A Sunburst chart is used to show division of data grouped into categories and sub-categories and the contribution of each sub-category to the whole. It represents data in series of concentric circles. The categories are represented in inner-most circle and sub-categories are represented in succeeding circles with sectors of size proportional to their values.

(e) A Funnel chart is used to show values across multiple stages in a process, from the initial stage to final stage. The data values are usually in increasing or decreasing order, making the chart resemble a funnel. In a funnel chart, categories are represented on the vertical axis and values are represented as rectangular bars.

4. To add chart elements:

   (1) On the Chart Tools Design tab, in the Chart Layouts group, click the Add Chart Elements down arrow.
      • A drop-down menu appears.

   (a) To add axis title:

      (1) Click Axis Title and select the axis for which you want to display the title.
      • An Axis Title placeholder appears.

      (2) Click in the text placeholder and change the title as desired.

      (3) Click anywhere outside the text placeholder to insert the title.

   (b) To add data table:

      (1) Click Data Table and select the type of table from the sub-menu that appears.
To add a chart title:

1. Click Chart Title and select a position for the chart title from the sub-menu that appears.
   - The Chart Title text placeholder appears.
2. Click in the text placeholder and change the chart title as desired.
3. Click anywhere outside the text placeholder to insert the title.

5. A combo chart combines two different chart types in one chart. Combo charts are used to display related data, such as rainfall and temperature of a place. To create a combo chart:
   a. Select the data you want to display by a combo chart.
   b. On the Insert tab, in the Charts group, click the Insert Combo Chart button.
      - A gallery of combo charts appears.
   c. Click the type of combo chart you want to create.
      - Excel inserts the selected combo chart in the worksheet.

6. Sparklines are compact charts which summaries a data series by using a graph contained within a single cell. To insert a Sparkline:
   a. Select the data you want to represent with Sparklines.
   b. On the Insert tab, in the Sparklines group, click the type of sparkline that you want to create: Line, Column or Win/Loss.
      - The Create Sparklines dialog box opens.
(c) In the Location Range box, specify the cell or cell range where you want the sparkline to appear.

(d) Click the OK button. Excel creates Sparklines for the selected cell range. The Sparkline Tools Design tab appears on the ribbon.

**E. 1. Column Chart**

2. ![Chart Title](image)
   ![Gridline](image)
   ![Chart Area](image)
   ![Data label](image)

**Think and Answer**

1. Lily should change the style of the chart.
2. Jack can change the type of chart from the Chart Tools Design tab, in the Type group. After changing the chart type, he can add Data Labels to it from Chart Tools Design tab in Chart Layouts group

**5. LOOPS AND GRAPHICS IN SMALL BASIC**

A. 1. For loop
2. PenWidth
3. DrawRectangle(x,y,l,b)
4. While loop
5. GraphicsWindow

B. 1. Iteration
2. Infinite loop
3. Step
4. While....EndWhile
5. FontName
C. 1. T 2. T 3. F
4. T 5. T

D. 1. The For...EndFor loop, or For loop, statement is used to execute a set of instructions for a specific number of times. It is useful when the number of iterations is known beforehand. The For...EndFor loop lets you define a variable, called counter variable, for the number of iterations and assign it an initial and final value. After each iteration, Small Basic increments the value of the counter variable by 1. The For loop executes till the value of counter variable is less than or equal to its final value.

For example, write a program to display the numbers from 1 to 5.

(a) Open a new program in Small Basic.

(b) In the Editor window, type the code as below:

1 For Num = 1 To 5
2 TextWindow.write (Num + " ")
3 EndFor

(c) Click the Run button on the Taskbar or press the F5 key.

   • The output of the program is displayed as:

     1 2 3 4 5 Press any key to continue...

In the above example, the counter variable Num is assigned the initial value 1 and the final value 5. When the value of Num becomes greater than 5, the loop terminates.

2. By default, the value of the counter variable in a For loop is incremented by 1 after each iteration. You
can increment counter variable by any other value (positive or negative), by using the keyword Step in the For statement.

Example: To write a program to display all odd numbers between 1 to 20.

(a) Open a new program in Small Basic.
(b) In the Editor window, type the code as shown below:

1  TextWindow.WriteLine(“The odd numbers from 1 to 20 are :”)
2  For Num = 1 to 20 Step 2
3   TextWindow.WriteLine(Num)
4  EndFor

(c) Click the Run button.
   • The output of the program will be displayed as :

   The odd numbers from 1 to 20 are :
   1
   3
   5
   7
   9
   11
   13
   15
   17
   19
   Press any key to continue...

3. The While...EndWhile loop, or While loop, is used to execute a set of instructions multiple times based on a condition. The While loop executes till the specified condition evaluates to true. It is useful when the number of repetitions is not known beforehand.
The syntax for the While...EndWhile loop is:

While (LoopCondition)
    <instructions to be executed>
    <Counter variable increment statement>
EndWhile

4. The Graphics Window object in Small Basic is used to perform graphics related input and output operations in the graphics window. It allows you to draw lines and shapes such as rectangle and ellipse, with different colors and thickness. It also lets you display text in different fonts and colors.

Properties of GraphicsWindow object related to text are:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>FontName</td>
<td>Sets the font used to display text in the graphics window.</td>
<td>GraphicsWindow. FontName = “Calibri”</td>
</tr>
<tr>
<td>FontSize</td>
<td>Sets the font size used to display text in the graphics window.</td>
<td>GraphicsWindow. FontSize = 20</td>
</tr>
<tr>
<td>FontBold</td>
<td>Sets whether the font used to display text in the graphics window is bold or not.</td>
<td>GraphicsWindow. FontBold = “True”</td>
</tr>
<tr>
<td>FontItalic</td>
<td>Sets whether the font used to display text in the graphics window is italic or not.</td>
<td>GraphicsWindow. FontItalic = “False”</td>
</tr>
</tbody>
</table>

5. (a) Title - Sets the title of the graphics window.

(b) BrushColor - Sets the color of the brush used to fill shapes drawn in the graphics window.

(c) BackgroundColor - Sets the background color of the graphics window.
(d) PenWidth - Sets the thickness of the pen used to draw shapes in the graphics window.

6. (a) DrawLine() - Draw a line from one point to another.
(b) FillRectangle() - Fills a rectangle at point in the graphics window.
(c) DrawText() - Displays a line of text on the screen at point.
(d) DrawEllipse() - Draws an ellipse at point in graphics window.

Think and Answer

1. 
```vbnet
A=2
While(A<=20)
    TextWindow.Write(“ ”+ A)
    A=A+2
Endwhile
TextWindow.Write(“ ”)
```

2. 
```vbnet
Sum = 0
For Num = 15 to 35
    Sum = Sum + Num
Endfor
TextWindow.WriteLine(“The sum of numbers from 15 to 35 = ” + Sum)
```

6. INTRODUCTION TO HTML5

Worksheet 6

A. 1. HTML editor 2. <br>
3. <!--DOCTYPE html> 4. <hr>
5. attribute
B. 1. WYSIWYG   2. Web browser   3. HTML
   4. tag   5. Comment
C. 1. F   2. F   3. T
   4. T   5. T
D. 1. Hypertext Markup Language (HTML) is a computer language used for creating web pages in the form of HTML documents. It describes the contents, format and layout in which a web page should be displayed over the World wide web (www).

Tags that form the basic structure of the HTML document are:

<!DOCTYPE html>
<html>
<head>
    <title>.....</title>
</head>
<body>

-----------------
</body>
</html>

2. A tag is a command that instructs the web browser how to display the desired content. An HTML tag always begins with a less than sign < and ends with a greater than sign >.

A Container tag is made up of a pair of tags – a START tag and an END tag eg. <head>.....</head>.

An Empty tag requires a START tag but not an END tag eg. <br>.

3. An HTML editor is a software that allows you to create web pages using HTML. There are two types of HTML editors - WYSIWYG and Text.
WYSIWYG Editors - WYSIWYG stands for What You See Is What You Get. WYSIWYG editors provide a graphical interface and tools to develop a web page and insert images, tables, audio and video in it. They allow a developer to view a web page as it would appear in a web browser. These editors allow you to create web pages without any knowledge of HTML. Some Popular WYSIWYG editors are - Google Web Designer and Adobe Dreamweaver.

Text Editors - Text Editors allows you to create web pages by writing HTML statements to describe how the content of the web page is to be displayed. You required a specialized knowledge of HTML to work with a text editor. Some Popular Text editors are - Notepad and Wordpad.

4. Some guidelines to be followed while creating HTML documents are:

(a) Tag name and attribute names are not case sensitive. However, it is recommended to use lowercase for tag names and attribute names.

(b) Enclose the attribute values within double quote.

(c) Spaces between tags and content are not important.

(d) Do not use spaces between tag names and between <and> signs.

5. Steps to view an HTML document in a Web Browser are:

(a) Open Internet Explorer.

(b) In the File menu, click Open or press Shift + O keys.

  • The Open dialog box opens.
(c) Click the Browse...button.
   • The Internet Explorer dialog box opens.

(d) Select the HTML document you want to view and click the Open button.

(e) Click the OK button in the Open dialog box.
   • Internet explorer displays the content of the selected HTML document.

6. (a) <br> is used to insert a new blank line or create a line break in an HTML document.

(b) <h1> is used to display text in larger and bolder font than the normal text.

(c) <b> is used to make text appear bold when viewed in a web browser.

(d) <hr> is used to add a horizontal line across a web page to separate blocks of information.

(e) <p> is used to start new paragraphs in an HTML document.

Think and Answer

1. To view the page in a web browser Aakriti should connect to internet and then type the path of the document on the address bar of Internet explorer.

2. Richard should use <b> and <hr> tags to emphasise and add a line after description of each site.

7. ADDING CSS STYLES IN HTML5

Worksheet 7

A. 1. Inline style             2. margin
    3. text-align              4. text-transform
    5. <body> tag
B. 1. margin 2. border-width 3. font style
   4. Color 5. text-shadow

C. 1. style sheet 2. selector 3. border-color
   4. font-family 5. style

D. 1. T 2. T 3. T
   4. F 5. F

E. 1. Cascading Style Sheets (CSS) is a style sheet language used to describe the presentation of an HTML document. A style sheet holds formatting codes that control the appearance of a web page.

   Syntax for writing a CSS Style rule is:
   
   Selector {property1:value1; property2:value2;.....}

   2. CSS styles can be inserted in an HTML document in one of the following ways:

   (a) Embedded (or internal) style sheet - An embedded style sheet is a part of an HTML document and is defined in the <head> section of the document, using the <style> element.

   (b) Inline Style - An inline style is defined in an HTML document inside the <body> section to specify formatting for specific elements.

   (c) External Style sheet - An external style sheet is a separate document that contains the style rules for various elements in a web page. It is specified in the HTML document in the <head> section.

   3. Font properties are used to specify the font, size and style for the text in a web page.
Some font properties are:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>font-family</td>
<td>Specifies a font for the text.</td>
<td>font-family: Arial</td>
</tr>
<tr>
<td>font-style</td>
<td>Specifies the style of font.</td>
<td>font-style: italic</td>
</tr>
<tr>
<td>font</td>
<td>Specifies all font properties in one declaration.</td>
<td>Font: bold 24px Calibri</td>
</tr>
</tbody>
</table>

4. Various properties used to style text in a web page are:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>color</td>
<td>Specifies the text colour.</td>
<td>color: blue</td>
</tr>
<tr>
<td>text-align</td>
<td>Specifies the horizontal alignment of text.</td>
<td>text-align: center</td>
</tr>
<tr>
<td>line-height</td>
<td>Specifies the distance between two lines.</td>
<td>line-height: normal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>line-height: 6px</td>
</tr>
<tr>
<td>text-decoration</td>
<td>Specifies the type of line that is added to the text.</td>
<td>text-decoration: underline</td>
</tr>
<tr>
<td>text-shadow</td>
<td>Specifies the shadow effect for the text.</td>
<td>text-shadow: 3px 3px blue</td>
</tr>
<tr>
<td>text-transform</td>
<td>Controls the capitalisation of the text.</td>
<td>text-transform: uppercase</td>
</tr>
</tbody>
</table>

5. Border properties are used to set the styles of the borders around an HTML element such as width, style and color.
Some border properties are:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>border-width</td>
<td>Specifies the thickness of the border.</td>
<td>border-width: 10px</td>
</tr>
<tr>
<td>border-style</td>
<td>Specifies the style of the border.</td>
<td>border-style: dashed</td>
</tr>
<tr>
<td>border-color</td>
<td>Specifies the colour of the border.</td>
<td>border-color: green</td>
</tr>
</tbody>
</table>

8. INTRODUCTION TO ANIMATE CC

Worksheet 8

A. 1. Merge Drawing Mode  2. Lasso tool
    3. .fla  4. Paint bucket tool
    5. gradient

B. 1. Pasteboard  2. Ink Bottle  3. Radial
    4. Properties Inspector  5. Erase Inside

C. 1. T  2. F  3. F
    4. T  5. T

D. 1. Fig A – Polystar Tool,  Fig. C – Oval Tool  2. Gradient Fill
    Fig. B – Line tool,

E. 1. Various components of Adobe Animate window are:
    (a) Application bar - The application bar present at the top of the animate window, provides various
menus such as File, edit, view and insert. You can use menus to perform basic tasks like opening, saving and printing animate files, cutting and pasting images or text, viewing your project in different ways, getting help and more. It also contains control buttons to minimize, maximise and close the animate window.

(b) Document window - The Document Window, present below the application bar, displays the document you are currently working on.

(c) Stage - The Stage present at the centre of the document window, is the rectangular white area where you draw shapes and pictures, display text, and make objects move across the screen.

(d) Pasteboard - The Pasteboard is the gray area that surrounds the stage. It is used to move objects on and off the stage. Items placed on the Pasteboard are not visible in the final animation.

(e) Tools panel - The Tools panel, presents at the right side of the animate window, contains various tools to create and edit graphics and text.

(f) Timeline - The Timeline, present below the Stage, is used to set the sequence and timings of various graphics and other elements of an animation. The Timeline organises and controls the content of an animation in the form of layers and frames.

(g) Properties inspector - The Properties Inspector present at the right of the Animate window displays the properties for the currently selected object and provides options to change its properties.
2. Adobe animate offers two drawing modes to draw shapes:

(a) Merge Drawing mode - It is the default drawing mode in Animate. It merges shapes that are drawn on top of one another. When you draw shapes that overlap each other in the same layer, the top most shape erases the part of the shapes underneath it. In this mode, stroke and fill of a shape are considered as separate elements and can be selected and moved independently.

(b) Object drawing mode - It treats each shape as separate object and does not automatically merge objects when overlapped. An object overlapping another object, does not affect the underlying objects when you move objects apart or rearrange their position. In this mode, stroke and fill of a shape are selected and moved as a single object.

3. To change the default settings of an animate document:

(1) On the Application bar, in the Modify menu, click Document... The Document Settings dialog box opens.

(2) Do any of the following:

- To specify the unit used to measure the ruler, click the Units list down arrow and select a unit.
- To specify the size of Stage, enter the values of width and height of stage in the Stage size boxes. By default, width and height of stage is 550 and 400 pixels respectively.
- To set the background color for the Stage, click the Stage color box and select a color from the colors palette.
• To change the frame rate (speed) of the animation, click the value next to Frame rate and drag the slider right or left to increase or decrease the frame rate respectively. The default frame rate is 24 frames per second (fps).

• To apply the current document settings to all new documents, click the Make Default button.

(3) Click the OK button.

• Animate modifies the settings as per the selected options.

4. To reshape lines or shape outlines:

(1) In the Tools Panel, click the Selection tool.

(2) Position the mouse pointer close to a line or an outline. A small shape appears at the bottom of the pointer, indicating how the line can be reshaped. A curve next to the pointer indicates that you can create a curve. A corner next to the pointer indicates that you can change the end points.

(3) Click and drag the line to reshape it.

5. To create a new gradient color:

(1) Click the Window menu and select Color option.

• The Color Panel opens.

(2) Select a gradient style from Color type drop-down menu.

• The gradient bar appears with two color markers, one for each color that forms your gradient.

(3) Double-click the color markers and select the color from the Swatches panel that appears.
(4) Click and drag the color markers toward left or right on the gradient bar to adjust the gradient.

(5) To add another color to the gradient, click below the gradient bar and select a colour for the marker.

6. (a) Polystar tool - It is used to draw polygons or stars.

(b) Brush tool - It is used to paint with brush like strokes. It can be used to create effects such as calligraphic effects.

(c) Paint bucket tool - It is used to fill the enclosed areas with a solid colour or a gradient. It can be used to fill empty areas and change the color of already painted areas. It also lets you fill areas that are not entirely closed.

(d) Lasso tool - It is used to create freeform selection area to select all objects contained within the area.

(e) Eraser tool - It is used to erase or remove the unwanted parts of an object from the stage. The eraser can be modified to erase only lines, only fills or only selected fills.

(f) Ink bottle tool - It is used to change the color, thickness or style of strokes or outlines of shapes.

Think and Answer

1. Divya has drawn the flower in Merge Drawing mode. To avoid so, she should draw the flower in Object Drawing mode.

2. To create a new gradient:

Robin should follow the given steps:
(a) Click the Window menu and select Color option.
   • The Color panel opens.

(b) Select a gradient style from Color type drop-down menu.
   • The gradient bar appears with two color markers, one for each color that forms your gradient.

(c) Double-click the color markers and select the color from Swatches panel that appears.

(d) Click and drag the color markers toward left or right on the gradient Bar to adjust the gradient.

(e) To add another color to the gradient, click below the Gradient bar and select a colour for the marker.

9. CREATING ANIMATIONS IN ANIMATE

A. 1. \text{F6} 2. Timeline 3. Frame-by-frame
    4. Onion skin 5. Symbol

B. 1. Symbol 2. playhead 3. keyframe
    4. Motion 5. library

C. 1. F 2. T 3. T
    4. T 5. F

D. 1. Frame - A Frame contains the content of an Animate document and is represented as small rectangular boxes across each layer in the Timeline.
   
   Keyframe - A Keyframe is created to mark significant points along the Timeline where content of a document changes. A keyframe with content is represented using a solid dot in the Timeline.

   To add a keyframe in the Timeline:
(a) On the Timeline, click a rectangular placeholder where you want to insert a keyframe.

(b) On the Application Bar, click Insert.
   • A menu appears.

(c) Point to the Timeline option and then click Keyframe.
   • Animate inserts a new keyframe in the timeline at the selected placeholder.

2. Frame by frame animation is created by changing the contents of the stage in every frame. It is best suited to create complex animation in which content changes continuously in different ways. In frame by frame animation, each frame acts as a keyframe and has content slightly different from the previous frame.

   Tweened animation is an effective way to create animation automatically. In tweened animation, you need to define the contents of the first keyframe and the last keyframe of the animation, and Animate fills in the frames between the two keyframes.

3. A symbol is a graphic, button or movie clip that is stored as a part of an animation. Any symbol that you create automatically becomes part of the library for the current document. To convert an object into a symbol:

   (a) Select an existing object on the stage you want to convert into symbol.

   (b) On the Application bar, click Modify and then click Convert to Symbol...
       • The Convert to Symbol dialog box opens.

   (c) In the Name box, type the name for the symbol.
(d) Click the down arrow in the Type box and select Graphic.

(e) Click the OK button.

• Animate converts the object into a symbol and adds it to the Library of the document.

4. Motion Tween lets you create animation of objects moving on the stage along a specified path. You need to specify the starting and the ending position of an object in the keyframes. Animate automatically fills the frames lying between the two keyframes to make the object move between the two positions. To apply motion tween, you need to convert an object into a symbol.

Shape Tween lets you create animation in which content of one frame changes into the content of another frame. You need to specify the content of the first as well as the second keyframe. Animate inserts the intermediate content for the frames in between the two keyframes, creating the animation. Shape Tween work on shapes.

5. The Onion Skin feature allows you to view the relative position of an object over several frames in an animation. This lets you place objects precisely in different frames to create smooth animations.

To use the Onion Skin feature, click the Onion Skin button at the bottom of the Timeline.

• Animate displays the content of the two frames each before and after the current frame, superimposed as one frame in the document window.

• The Start Onion Skin and End Onion Skin markers appear in the Timeline. You can control the
number of onion skins displayed by dragging the Start Onion Skin and End Onion Skin markers.

6. The Timeline is the area that lets you create animation by setting the sequence and timings of various objects in an Animate document. It lets you organise and control the content of an animation using layers, frames and keyframes.

Different components of timeline are:

(a) Layers - Layers help you organise the objects, animations and other elements in an Animate document. Layers can be imagined as multiple transparent pages stacked on top of one another. Each layer can contain a different image that appears on the stage.

(b) Frames - Rectangular boxes across each layer in the timeline which contain the content of an animate document are called frames.

(c) Keyframes - Keyframes are created to mark significant points along the timeline where content of a document changes.

(d) Playhead - The red marker in the timeline is called the playhead. It indicates the current frame displayed on the stage. When an animation plays, the playhead moves from left to right through the frames in the timeline.

Think and Answer

1. Motion Tween
2. Shape Tween
10. COMPUTER MALWARE

Worksheet 10

A. 1. Antivirus software 2. Program Virus
   3. Polymorphic Virus 4. Spam
   5. Identity theft

B. 1. Macro Virus 2. Hacking
   3. Virus Definition 4. Trojan Horses
   5. Data theft

C. 1. F 2. T 3. F
   4. T 5. T

D. 1. Quick Heal Total security, Norton security
   2. Gator, Zango
   3. DeskAd, Bonzibuddy
   4. Disk killer, Brain
   5. Morris, Mydoom

E. 1. Malware is a Malicious Software, designed to gain access or damage a computer without the knowledge of the user. Malware includes Viruses, Worms, Trojan Horses, Spyware, Adware, Ransomware and many more.

Five measures you should follow to minimize the risk of malware infection in a computer system are:

(a) Install an antivirus program and scan your computer regularly for malware.
(b) Update your antivirus software regularly.
(c) Use software from trusted sources only and scan it before installing.
(d) Always open email attachment after scanning them.
(e) Always scan files downloaded from the internet, transferred through a network or copied from removable media.
2. A virus is a software that can replicate itself and cause harm to the operating system, other application software or data files in a computer. It can spread from program to program, or disk to disk, manipulating and damaging valuable data without the user's knowledge.

Different types of viruses are:

(a) Boot Sector Virus - A Boot Sector Virus infects boot record program in a hard disk, responsible for loading the operating system in the memory.

(b) Program Virus - A Program Virus infects executable program files installed in a computer that have extensions such as .exe, .com, .sys, .bat, .dll, .bin and .pif. When the infected program is executed, the virus becomes active in the memory, making copies of itself and infecting all files accessed by the infected program.

(c) Macro Virus - A Macro Virus infects macros software such as Microsoft Word, Excel and PowerPoint. Macro virus infects documents that use the infected macros and overwrite or completely destroy the data in the documents.

(d) Multipartite Virus - A Multipartite Virus infects a computer and spreads in multiple ways. It attacks both the boot sector and the program files.

(e) Polymorphic Virus - A Polymorphic Virus is a self-encrypted virus designed to avoid detection by antivirus software. It changes its program code every time it replicates and infects a new file.
3. A Trojan Horse is a program that hides its destructive intentions by disguising itself as a game, useful applications or utility. It is usually distributed as email attachments with tempting names and descriptions that prompt a user to open them. It can delete files from a disk, send your personal information such as passwords, or give remote access of your computer to cyberthieves and hackers. Beast, DarkComet and Zeus are some examples of trojan horses.

4. (a) Spam - Spam is an unsolicited and unwanted email message. It is usually sent by companies to advertise and sell their products and services. It may include malware as scripts or other executable file attachments. Spam occupies the storage space that is meant for important email messages.

(b) Phishing - Phishing is a fraudulent practice to send email messages, which appear to be from a genuine source, in order to induce individuals to reveal their personal information, such as passwords, credit card numbers or other financial details. The email message may contain links to other websites that are infected with malware.

(c) Adware - Adware is an advertising supported software downloads or displays unwanted advertisements in your computer system in order to generate revenue for its author. It can reduce productivity and efficiency of a user. It tracks the browsing habits of a user and redirects search requests to certain advertising websites.

(d) Hacking - Hacking is an unauthorized illegal activity to gain access to computers and network resources. The person engaged in hacking activities is referred as Hacker. A hacker finds weakness in the security
of computer systems or networks and exploits it to damage or steal confidential information.

(e) Identity Theft - Identity Theft is the act of stealing a user’s online identity such as username and password to pose as that person, and send messages and emails from his online profile. It leads to social disrepute of a person.

5. An Antivirus Software is a utility software designed to protect the computer from viruses and other malicious software. It scans the internal memory, hard disk and external media attached to the computer to identify, isolate and eliminate viruses. It also examines the incoming files for viruses as the computer receives them.

Virus definition refers to the database of virus signature files that an antivirus software uses to scan a computer. Since, new viruses are developed and released from time to time, it is essential to update virus definition at regular intervals.

6. Malware can harm the computer in many ways. Some of them are:

(a) It can slow down the speed of the computer.
(b) It can corrupt the program and data files stored in the computer.
(c) It can prevent access to a network.
(d) It may open unwanted pop-up windows on the computer.
(e) It allows hackers to access sensitive information stored in the computer.

Think and Answer

1. Samuel’s computer is infected by a Virus.
2. Hardik should have not updated the virus definitions
or his computer might be infected by polymorphic virus. He can avoid this problem in future by following preventive measures:

(a) Install an antivirus program and scan your computer regularly for malware.
(b) Update antivirus software regularly.
(c) Use software from trusted sources only and scan it before installing.
(d) Always open email attachment after scanning them.
(e) Always scan files downloaded from the Internet, transferred through a network or copied from removable media.
(f) Install a firewall program to filter incoming and outgoing messages on a network.
(g) Adjust security settings in the browser to ensure maximum protection from malware.
(h) Never use pirated software.

11. INTERNET SERVICES

Worksheet 11

    3. 280 4. E-Commerce
    5. Cloud Computing

B. 1. Feed Reader 2. Viber 3. E-Learning
    4. Blogging 5. Web Feed

C. 1. F 2. T 3. F
    4. T 5. T

D. 1. WWW.w3schools.com, WWW.gcflearnfree.org
    2. Flipkart.com, Paytm.com
    3. Facebook, Twitter
4. Microsoft One Drive, Google Drive
5. WhatsApp, Facebook Messenger.

E. 1. (a) Instant Messaging - Instant Messaging is a real time communication service, widely used to communicate between two or more known users over the internet. IM allows users to send text, emoticons, images or videos to other users.

(b) Internet Telephony - Internet Telephony is a communication service that allows a user to make voice calls over the Internet to another user using a personal computer equipped with speakers and microphone. It enables you to make calls from a computer to another computer or from a computer to a telephone. You can also make video calls using a smartphone or a webcam.

2. Social networking site is an online platform where users create their personal profiles to interact with others to maintain personal and business relationships. Social networking sites are used by people to talk to other people, share ideas and interests or make new friends and clients. Some popular social networking sites are Facebook and Twitter.

3. (a) E-Learning - It refers to the use of technology that enables a user to learn from anyplace at anytime. It includes all kind of learning services, offline or online, such as multimedia DVD’s, computer-based tutorials and online courses.

(b) E-Governance - It refers to the use of information technology by the national or local government to provide information and services to its citizens. E-governance helps the government to
perform in an efficient and transparent manner. Several government websites have been set up to provide various services such as birth/death registration, online tax payment, online ticket booking, Right to information, etc. that enable a user to avail these services in a convenient manner at affordable cost.

(c) E-commerce - It involves all financial activities and services conducted over the internet. It includes online shopping, online banking, trading of stocks and bonds, online ticket booking, and transmitting of funds and digital documents. It enables an individual or an organisation to conduct cashless financial transactions using electronic modes of payment such as credit cards, debit cards, e-wallets, netbanking and mobile banking.

(d) E-card - It is an online service that lets a user send an electronic greeting card to another user as email with a link to view the card. An e-card can contain text, audio and animation, and may be interactive. You can send e-cards to your friends and relatives on their birthdays, anniversaries and other occasions.

4. Cloud computing is a technology that uses internet and central remote servers to store, maintain and process data and applications. It enables a user to access applications without installing the software in the computer. Cloud computing services are provided on-demand and are hosted by cloud service providers. The cloud storage space available to a user can be increased as per requirement. Microsoft Office 365 and Google Docs are some examples of cloud services.

5. Online gaming is a service that lets you play games over the internet or any other computer network.
To play online games, you require:
(a) A high-speed internet connection.
(b) Gaming software.
(c) A graphics display card, fast processor and large primary memory.
(d) Gaming control devices, such as joystick or game controller.
(e) Latest flash player and web browser.

Think and Answer

1. Lily can use Internet Telephony as Instant Messaging Services to talk to his brother.
2. Ritu should use Blog service to do so.
3. Sumit must have used E-commerce service to pay the bill.

ASSESSMENT SHEET – 1

1. (a) D (b) = J7 + K$4 (c) Flash Fill
   (d) Gridlines (e) GraphicsWindow
2. (a) Step (b) Legend (c) Format Painter
   (d) absolute (e) face value
3. (a) F (b) T (c) T
   (d) F (e) F
4. (a) i. \[
\begin{array}{c|c}
2 & 84 \\
2 & 42 & 0 \\
2 & 21 & 0 \\
2 & 10 & 1 \\
2 & 5 & 0 \\
2 & 2 & 1 \\
2 & 1 & 0 \\
0 & 1 \\
\end{array}
\]
\[(84)_{10} = (1010100)_{2}\]
ii. \((110011)_2\)
   \[= 1 \times (2)^5 + 1 \times (2)^4 + 0 \times (2)^3 + 0 \times (2)^2 + 1 \times (2)^1 + 1 \times (2)^0\]
   \[= 32 + 16 + 0 + 0 + 2 + 1\]
   \[= 51\]
   \((110011)_2 = (51)_{10}\)

(b) i.  

\[
\begin{array}{cccc}
0 & 1 & 0 & X \ 0 & 1 \\
- & 1 & 0 & 0 & 1 & 1 \\
\hline
& 0 & 0 & 0 & 1 & 0 \\
\end{array}
\]

ii.  

\[
\begin{array}{cccc}
1 & 1 & 0 & 1 & 1 \\
\times & 1 & 1 & 0 & 1 \\
\hline
0 & 0 & 0 & 0 & 0 & \times \\
1 & 1 & 0 & 1 & 1 & \times & \times \\
1 & 1 & 0 & 1 & 1 & \times & \times \\
\hline
1 & 1 & 1 & 1 & 1 & 1 & 1 & 1 \\
\end{array}
\]

5. (a) \text{SUM(B4:F4)}

(b) \text{AVERAGE(C3:C6)}

(c) Sparkline

6. (a) To convert a decimal number into a binary number
   - Divide the decimal number by two.
   - Write the remainder on the right-hand side.
   - Continue the process till you reach 0 as quotient.
   - Write the remainders from bottom to top to form binary equivalent of the decimal number. The first remainder becomes the last binary digit, and the final remainder becomes the first binary digit.

(b) The Graphics Window object is Small Basic is used to perform graphics related input and output operations in the graphics window. It allows you to draw lines and shapes such as rectangle and ellipse, with different colors and thickness. It also lets you display text in different fonts and colors.
Properties of graphics Window object related to text are:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>FontName</td>
<td>Sets the font used to display text in the graphics window.</td>
<td>GraphicsWindow. FontName = “Calibri”</td>
</tr>
<tr>
<td>FontSize</td>
<td>Sets the font size used to display text in the graphics window.</td>
<td>GraphicsWindow. FontSize = 20</td>
</tr>
<tr>
<td>FontBold</td>
<td>Sets whether the font used to display text in the graphics window is bold or not.</td>
<td>GraphicsWindow. FontBold = “True”</td>
</tr>
<tr>
<td>FontItalic</td>
<td>Sets whether the font used to display text in the graphics window is italic or not.</td>
<td>GraphicsWindow. FontItalic = “False”</td>
</tr>
</tbody>
</table>

(c) (1) A sunburst chart is used to show division of data grouped into categories and sub-categories and the contribution of each sub-category to the whole. It represents data in series of concentric circles. The categories are represented in inner-most circle and sub-categories are represented in succeeding circles with sectors of size proportional to their values.

(2) A combo chart combines two different chart types in one chart. Combo charts are used to display related data, such as rainfall and temperature of a place.

(3) A Pie chart is used to display the relationship of individual data values to the sum of all the data values in a given series. It represents data in form of a circle divided into various sectors. The size of a sector is proportional to the percentage of the data value it represents.
(d) The filter feature in Excel 2016 is used to display the rows that meet a specific criterion and hide rows that do not satisfy the criteria. You can use this feature to find and work with specified data in a cell range.

To filter data on specific values in a cell range:
(a) Click a cell in the range that you want to filter.
(b) On the Data tab, in the Sort & Filter group, click the Filter button.
   • The Filter Control appears next to each column heading.
(c) Click the Filter Control of the column heading on which you want to specify the filter condition.
   • The filter menu appears. It displays a list of all unique values in the column.
(d) Remove the check marks for the values you want to hide

OR

Remove the check marks before Select All and then, check mark the values you want to display.
(e) Click the OK button.
   • Excel displays the rows containing the cells that match your filter condition.
   • The row numbers of the filtered rows turn blue. A filter icon appears in the column heading of the column on which the filter is applied.

(e) Five common errors that occur while using formula are:
### Error Reason

<table>
<thead>
<tr>
<th>Error</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>#   -</td>
<td>Occurs when a column is not wide enough to display the result.</td>
</tr>
<tr>
<td>#VALUE!</td>
<td>Occurs when a formula contains invalid data.</td>
</tr>
<tr>
<td>#DIV/0!</td>
<td>Occurs when a number is divided by 0.</td>
</tr>
<tr>
<td>#N/A</td>
<td>Occurs when a value that a formula uses is not available.</td>
</tr>
<tr>
<td>#NAME</td>
<td>Occurs when the text in a formula is not recognized by Excel.</td>
</tr>
</tbody>
</table>

---

**ASSESSMENT SHEET – 2**

1. (a) `<!DOCTYPE html>`
   (b) Merge Drawing Mode  
   (c) Symbol  
   (d) Spam  
   (e) Cloud computing
2. (a) E-Learning (b) Virus definition  
   (c) motion  
   (d) Style Seet  
   (e) HTML
3. (a) T  
   (b) T  
   (c) T  
   (d) T  
   (e) F
4. (a) `<b>` tag  
   (b) `<br>` tag  
   (c) Color : red  
   (d) line-height : 15px  
   (e) font-family : Bookman
5. (a) Quick Heal Total Security, Norton Security  
   (b) Gator, Zango  
   (c) Flipkart.com, Paytm.com  
   (d) Facebook, Twitter  
   (e) Sunday, Cascade
6. (a) Shape tween  
   (b) 13  
   (c) 0.5s  
   (d) 24.00 fps  
   (e) 2
7. (a) Cloud computing is a technology that uses internet and central remote servers to store, maintain and
process data and applications. It enables a user to access applications without installing the software in the computer. Cloud computing services are provided on-demand and are hosted by cloud service providers. The cloud storage space available to a user can be increased as per requirement. Microsoft Office 365 and Google Docs are some examples of cloud services.

(b) An Antivirus Software is a utility software designed to protect the computer from viruses and other malicious software. It scans the internal memory, hard disk and external media attached to the computer to identify, isolate and eliminate viruses. It also examines the incoming files for viruses as the computer receives them.

Virus definition refers to the database of virus signature files that an antivirus software uses to scan a computer. Since, new viruses are developed and released from time to time. It is essential to update virus definition at regular intervals.

(c) Motion Tween lets you create animation of objects moving on the stage along a specified path. You need to specify the starting and the ending position of an object in the keyframes. Animate automatically fills the frames lying between the two keyframes to make the object move between the two positions. To apply motion tween, you need to convert an object into a symbol.

Shape Tween lets you create animation in which content of one frame changes into the content of another frame. You need to specify the content of the first as well as the second keyframe. Animate inserts the intermediate content for the frames in between the two keyframes, creating the animation. Shape Tween work on shapes.
(d) Hypertext Markup Language (HTML) is a computer language used for creating web pages in the form of HTML documents. It describes the contents, format and layout in which a web page should be displayed over the World wide web (www).

Tags that form the basic structure of the HTML document are:

```html
<!DOCTYPE html>
<html>
<head>
  <title>.....</title>
</head>
<body>
  
  
</body>
</html>
```

(e) Cascading Style Sheets (CSS) is a style sheet language used to describe the presentation of an HTML document. A style sheet holds formatting codes that control the appearance of a web page.

Syntax for writing a CSS Style rule is:

Selector {property1:value1; property2:value2;.....}

---

**CYBER QUEST**

1. 297
2. <h6>
3. Polymorphic virus
4. **F6**
5. Inline style
6. .fla
7. Sparkline
8. #DIV/0!
9. 6 times
10. Web Feed
11. PMCOREUT
12. 12.9
13. 200
14. 392, 576
15. 
16. 81
17. Volume
18. 
19. Cousin
20. Loss of 25%